
M72 series

user manual

It is important to read this user manual prior to using your new product for the first time.
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Important safety instructions

PLEASE READ AND SAVE FOR FUTURE REFERENCE

IMPORTANT SAFETY INSTRUCTIONS

Some of the following information may not apply to your particular product; however, as with any electronic 
product, precautions should be observed during handling and use.
• Read these instructions. 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water. 
• Clean only with dry cloth. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including 

amplifiers) that produce heat. 
• Only use attachments/accessories specified by the manufacturer. 
• Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been 

damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects 
have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate 
normally, or has been dropped. 

ADDITIONAL SAFETY INFORMATION
•  Apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases, 

shall be placed on the apparatus.
•  Do not attempt to disassemble the cabinet. This product does not contain customer serviceable 

components.
• The marking information is located at the bottom of apparatus.
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Important battery information
Warning: Your product contains a battery and charging system which is designed to work in temperatures 
that do not exceed 50°C (122°F). Leaving this product in a closed automobile or the trunk of an automobile 
where temperatures may exceed 50°C may result in permanent battery damage, fire, or explosion. Please 
remove your product from the automobile when you exit, do not place your product in the trunk of your 
automobile, and do not leave your product in any location where temperatures may exceed 50°C.

Ecology 
Your product must be disposed of properly according to local laws and regulations. Because this product 
contains a battery, the product must be disposed of separately from the household waste.

Precautions for the unit
• Do not use the unit immediately after transportation from a cold place to a warm place; condensation 

problems may result. 
• Do not store the unit near fire, places with high temperature or in direct sunlight. Exposure to direct 

sunlight or extreme heat (such as inside a parked car) may cause damage or malfunction.
• Do not expose to rain or moisture.
• Clean the unit with a soft cloth or a damp chamois leather. Never use solvents.
• The unit must only be opened by qualified personnel.

Headset safety 
To use a headset safely, please keep the following in mind:
• Do not play your headset at a high volume. Hearing experts advise against continuous extended play.
• If you experience ringing in your ears, turn down the volume or stop using the headset.
• Do not use a headset while driving a motorized vehicle or riding a bike. It may cause a traffic hazard and 

is illegal in many areas.
• Even if your headset is an open-air type designed to let you hear outside sounds, don’t turn up the 

volume so high that can’t hear sounds around you.
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FCC Information

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. 

However, there is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:
•  Reorient or relocate the receiving antenna.
•  Increase the separation between the equipment and receiver.
•  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by Audiovox could void the user’s authority to operate the 
equipment.

Manufacturer/Responsible Party 
Audiovox Accessories Corporation 
111 Congressional Blvd., Suite 350 
Carmel, IN  46032 

1-317-810-4880 ( No technical /product support is available via this number. This phone number is for 
regulatory matters only.) 
Visit www.rcaaudiovideo.com for technical support

This Class B digital apparatus complies with 
Canadian ICES-003.
Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada.

RCA RCA 
M7204M7204

RCA RCA 
M7208M7208
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End user license agreement

End user license agreement

IMPORTANT:  THIS WINDOW CONTAINS TWO SEPARATE END USER LICENSE AGREEMENTS (“EULA”):  1) THE 
AUDIOVOX CORPORATION EULA AND 2) THE GET DIGITAL DATA LLC EULA.  BY INSTALLING THE 
FOLLOWING PROGRAM OR CLICKING ON THE ACEPTANCE BUTTON OF THE PROGRAM, COPYING OR 
OTHERWISE USING THE PROGRAM, YOU ACKNOWLEDGE AND AGREE THAT YOU HAVE READ EACH EULA, 
UNDERSTAND EACH EULA, AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF EACH EULA.  

1. AUDIOVOX CORPORATION EULA

AUDIOVOX CORPORATION
END USER LICENSE AGREEMENT

IMPORTANT: READ CAREFULLY BEFORE DOWNLOADING OR INSTALLING THIS SOFTWARE!

THIS END USER LICENSE AGREEMENT (THIS “EULA”) IS A LEGAL AGREEMENT BETWEEN YOU AND AUDIOVOX 
CORPORATION AND, AS APPLICABLE, ANY AUDIOVOX SUBSIDIARY, AS DEFINED BELOW (COLLECTIVELY 
“AUDIOVOX”), FOR THE RCA BRANDED PORTABLE DIGITAL AUDIO/VIDEO DEVICE APPLICATION/DRIVER 
SOFTWARE PROGRAM WHICH MAY INCLUDE ASSOCIATED SOFTWARE COMPONENTS, SOFTWARE LICENSED 
BY AUDIOVOX FROM THIRD PARTIES (“LICENSORS”) AND ASSOCIATED DOCUMENTATION, IF ANY 
(COLLECTIVELY, THE “PROGRAM”). THIS EULA CONTAINS IMPORTANT LEGAL LIMITATIONS, RESTRICTIONS AND 
DISCLAIMERS, AND ALSO SPECIFIES THE DURATION OF YOUR LICENSE.
BY INSTALLING THE PROGRAM OR CLICKING ON THE ACCEPTANCE BUTTON OF THE PROGRAM, COPYING OR 
OTHERWISE USING THE PROGRAM, YOU ACKNOWLEDGE AND AGREE THAT YOU HAVE READ THIS EULA, 
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. THIS PROGRAM IS PROTECTED 
BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL 
PROPERTY LAWS AND TREATIES.  YOU MAY USE THE PROGRAM ONLY IN ACCORDANCE WITH THIS EULA, AND 
ANY SUCH USE IS HEREBY UNDERSTOOD TO BE CONDITIONAL UPON YOUR SPECIFIC AGREEMENT TO THE 
UNMODIFIED TERMS SET FORTH HEREIN.  IF YOU DO NOT AGREE WITH ALL OF THE TERMS OF THIS EULA, 
CLICK ON THE REJECTION BUTTON AND/OR DO NOT INSTALL THE PROGRAM AND/OR DO NOT USE THE 
PROGRAM.  

1. LICENSE
(a) Under this EULA, you are granted a non-exclusive, non-sublicenseable, non-assignable and non-
transferable (except as expressly set forth below) license (i) to use and install the Program on a single 
workstation, and (ii) to make one (1) copy of the Program into any machine-readable form for backup of the 
Program, provided the copy contains all of the original Program's proprietary notices.  
(b) You may transfer the Program and license to another party only as a part of the RCA branded Portable 
Digital Audio/Video Device (“A/V Device”), and only if the other party agrees to accept the terms and 
conditions of this EULA.  If you transfer the Program, you must at the same time either transfer all copies to 
the same party or destroy any copies not transferred.
(c) The terms of this EULA will govern any software upgrades or updates provided by AUDIOVOX that replace 
and/or supplement the original Program, unless such upgrade or update is accompanied by separate license 
terms and conditions in which case the terms of that separate license will govern.  You acknowledge and 
agree that AUDIOVOX may automatically download upgrades or updates to the Program software to your 
computer in order to update, enhance, and/or further develop the Program.  

2. LICENSE RESTRICTIONS
(a) Except for the licenses expressly granted to you in this EULA, no other licenses or rights are granted or 

This is a copy of the EULA that you need to agree to in order to use this product.
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implied.
(b) You may not (i) make the Program available over a network where it could be used by multiple 
computers at the same time; (ii) modify, translate, reverse engineer, decompile, disassemble (except to the 
extent that this restriction is expressly prohibited by law), or create derivative works based upon the 
Program; (iii) copy the Program, except as expressly permitted herein; (iv) remove or alter any copyright 
notices on all copies of the Program; or (v) rent, lease or lend the Program.  You agree that you shall only use 
the Program in a manner that complies with all applicable laws in the jurisdictions in which you use the 
Program, including, but not limited to, applicable restrictions concerning copyright and other intellectual 
property rights.  
(c) The Program may contain pre-release code that does not perform at the level of a final code release.  In 
such case, the Program may not operate properly. Updated versions of the Program may be downloaded 
from www.rcaaudiovideo.com/downloads
(d) AUDIOVOX is not obligated to provide support services for the Program.
(e) The Program is provided with “RESTRICTED RIGHTS”. Use, duplication, or disclosure by the U.S. 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of DFARS 252.227-7013, or FAR 
52.227-19, or in FAR 52.227-14 Alt. III, as applicable.

3. TERM AND TERMINATION
(a) Your license is effective on the date you accept this EULA and remains in effect until this EULA is 
terminated by either party.
(b) You may terminate this EULA and the associated license, without any notice or delay, by destroying or 
permanently erasing the Program and all copies thereof.  
(c) If you fail to comply with any of the terms of this EULA, in whole or part, your license will automatically 
terminate without notice from AUDIOVOX.
(d) Upon termination of this EULA and your associated license, you shall cease all use of the Program and 
destroy or permanently erase the Program and all full or partial copies thereof.

4. WARRANTY DISCLAIMER
THE PROGRAM IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE OR NON-INFRINGEMENT. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU (AND NOT 
AUDIOVOX, ITS SUPPLIERS, OR ITS DEALERS) ASSUME THE ENTIRE COST FOR ALL NECESSARY REPAIR OR 
CORRECTION.
This exclusion of warranty may not be allowed under some applicable laws. As a result, the above exclusion 
may not apply to you, and you may have other rights depending on the law that applies to you.

5. OWNERSHIP RIGHTS
All title and intellectual property rights, including but not limited to copyrights, in and to the Program and 
any copies thereof are owned by AUDIOVOX, its Licensors or its suppliers.  All title and intellectual property 
rights in and to the content which may be accessed through use of the Program is the property of the 
respective content owner and may be protected by applicable copyright or other intellectual property laws 
and treaties. This license grants you no rights to use such content.  All rights not expressly granted are 
reserved by AUDIOVOX or its Licensors. 

6. LIMITATION OF LIABILITY
(a)  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AUDIOVOX, OR ITS 
DEALERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, 
CORRUPTION OF FILES, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) REGARDLESS 
OF CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT, OR NEGLIGENCE, ARISING OUT OF YOUR USE 
OF OR INABILITY TO USE THE PROGRAM, EVEN IF AUDIOVOX HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.  BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
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LIMITATION OF LIABILITY OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU.
(b)  YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THE APPROPRIATE PROGRAM TO ACHIEVE YOUR 
INTENDED RESULTS, AND FOR THE INSTALLATION, USE, AND RESULTS OBTAINED.

7. WINDOWS MEDIA 
The software embedded within your A/V Device (the “Device Firmware”) contains software licensed from 
Microsoft that enables you to play Windows Media Audio (WMA) files (“WMA Software”).  The WMA Software 
is licensed to you for use with your A/V Device under the following conditions.  By installing and using this 
version of the Device Firmware, you are agreeing to these conditions.  IF YOU DO NOT AGREE TO THE END 
USER CONDITIONS OF THIS SECTION 7, DO NOT INSTALL OR USE THIS VERSION OF THE DEVICE FIRMWARE.

The WMA Software is protected by copyright and other intellectual property laws.  This protection also 
extends to documentation for the WMA Software, whether in written or electronic form.

GRANT OF LICENSE:  The WMA Software is only licensed to you as follows: 
You may use this version of the Device Firmware containing the WMA Software only as such use relates to 
your A/V Device.

You may not reverse engineer, decompile, or disassemble the WMA Software, except and only to the extent 
that such activity is expressly permitted by applicable law. 
You may transfer your right to use the Device Firmware only as part of a sale or transfer of your A/V Device, 
on the condition that the recipient agrees to the conditions set forth herein.  If the version of the Device 
Firmware that you are transferring is an upgrade, you must also transfer all prior versions of the Device 
Firmware that you have which include the WMA Software.
MICROSOFT IS NOT PROVIDING ANY WARRANTY OF ANY KIND TO YOU FOR THE WMA SOFTWARE, AND 
MICROSOFT MAKES NO REPRESENTATION CONCERNING THE OPERABILITY OF THE WMA SOFTWARE.

The WMA Software is of U.S. origin.  Any export of this version of the Device Firmware must comply with all 
applicable international and national laws, including the U.S. Export Administration Regulations, that apply 
to the WMA Software incorporated in the Device Firmware.
Content owners use Windows Media digital rights management technology (“WMDRM”) to protect their 
intellectual property, including copyrights.  This device uses WMDRM software to access WMDRM-protected 
content.  If the WMDRM software fails to protect the content, content owners may ask Microsoft to revoke 
the software’s ability to use WMDRM to play or copy protected content.  Revocation does not affect 
unprotected content.  When you download licenses for protected content, you agree that Microsoft may 
include a revocation list with the licenses.  Content owners may require you to upgrade WMDRM to access 
their content.  If you decline to accept an upgrade, you will not be able to access content that requires the 
upgrade.

8. THIRD PARTY SOFTWARE
ANY THIRD PARTY SOFTWARE THAT MAY BE PROVIDED WITH THE PROGRAM IS INCLUDED FOR USE AT YOUR 
OPTION.  IF YOU CHOOSE TO USE SUCH THIRD PARTY SOFTWARE, THEN SUCH USE SHALL BE GOVERNED BY 
SUCH THIRD PARTY'S LICENSE AGREEMENT, AN ELECTRONIC COPY OF WHICH WILL BE INSTALLED IN THE 
APPROPRIATE FOLDER ON YOUR COMPUTER UPON INSTALLATION OF THE SOFTWARE.  AUDIOVOX IS NOT 
RESPONSIBLE FOR ANY THIRD PARTY’S SOFTWARE AND SHALL HAVE NO LIABILITY FOR YOUR USE OF THIRD 
PARTY SOFTWARE.

9. GOVERNING LAW
If you acquired this A/V Device in the United States, this EULA shall be governed and construed in 
accordance with the laws of the State of Indiana, U.S.A. without regard to its conflict of laws principles. If you 
acquired this A/V Device outside the United States or the European Union, then local law may apply.
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10. GENERAL TERMS
This EULA can only be modified by a written agreement signed by you and AUDIOVOX, and changes from 
the terms and conditions of this EULA made in any other manner will be of no effect.  If any portion of this 
EULA shall be held invalid, illegal, or unenforceable, the validity, legality, and enforceability of the remainder 
of the Agreement shall not in any way be affected or impaired thereby.  This EULA is the complete and 
exclusive statement of the agreement between you and AUDIOVOX, which supersedes all proposals or prior 
agreements, oral or written, and all other communications between you and AUDIOVOX, relating to the 
subject matter of this hereof.  AUDIOVOX’S Licensors shall be considered third party beneficiaries of this 
Agreement and shall have the right to enforce the terms herein.
 “AUDIOVOX SUBSIDIARY” shall mean any person, corporation, or other organization, domestic or foreign, 
including but not limited to subsidiaries, that is directly or indirectly controlled by Audiovox Corporation 
including, but not limited to, Audiovox Consumer Electronics, Inc. and Audiovox Electronics Corporation.  For 
purposes of this definition only, the term “control” means the possession of the power to direct or cause the 
direction of the management and policies of an entity, whether by ownership of voting stock or partnership 
interest, by contract, or otherwise, including direct or indirect ownership of at least fifty percent (50%) of the 
voting interest in the entity in question.

11. CONSENT TO USE OF DATA
You agree that Audiovox and its subsidiaries may collect and use technical and related information that does 
not personally identify you, including but not limited to offers opted into by you with Audiovox partners, 
technical information about your computer, system and application software, IP address and peripherals, 
that is gathered periodically to facilitate the provision of software updates, product support and other 
services to you (if any) related to the RCA easyRip Software and to verify compliance with the terms of this 
License.  Audiovox may use this information, as long as it is in a form that does not personally identify you, 
to improve our products or to provide services or technologies to you. 

 2. GET DIGITAL DATA LLC EULA

DATA SERVICES
END USER LICENSE AGREEMENT

PLEASE READ THIS AGREEMENT.  This text is an important legal agreement between you “End User” (You, 
including Your company, if this Software will be used for the benefit of any corporation, partnership or any 
other legal entity), and Get Digital Data, LLC (“Get Digital Data”) YOU MUST AGREE to these terms and 
conditions before downloading, copying, executing, logging in, installing, using, or in any way copying the 
Software, and being allowed access to Get Digital Data’s databases to view and retrieve metadata, so please 
read carefully.

WITNESSETH:

WHEREAS, GET DIGITAL DATA is in the business of compiling and hosting certain databases that supply 
metadata for CDs;

WHEREAS, END USER desires to be allowed access to Get Digital Data’s databases to view and retrieve 
metadata; and

WHEREAS, GET DIGITAL DATA desires to grant to END USER and END USER desires to obtain from GET 
DIGITAL DATA a non-exclusive license to be allowed access to such databases in accordance with the terms 
and on the conditions set forth in this Agreement.

NOW, THEREFORE, in consideration of the promises and agreements set forth herein, the parties, each 
intending to be legally bound hereby, do promise and agree as follows. 
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1.  DEFINITIONS
A.  “Metadata” means information and data related to CDs which GET DIGITAL DATA has stored into 
databases, including factual information such as titles, authors, and content identifying information and also 
including potentially copyrighted materials related to the CDs such as cover artwork and summary album 
information.
B.  “Designated Equipment” shall mean the hardware product purchased by the END USER which is software 
enabled to access GET DIGITAL DATA’s Metadata databases.   

2.  LICENSE GRANT
GET DIGITAL DATA hereby grants to END USER a non-exclusive right and license to use the Designated 
Equipment to access and retrieve Metadata from GET DIGITAL DATA’s CD Databases. 

3.  DELIVERY
Upon acceptance of this END USER LICENSE AGREEMENT, GET DIGITAL DATA shall authorize the Designated 
Equipment to access the Metadata.  Conditional access to the Metadata does require the installation of 
appropriate software, provided by the manufacturer of the Designated Equipment.

4.  LIMITATION ON COPIES AND ACCESS
A.  END USER may retrieve, copy and display Metadata solely for personal use, and shall not copy, collect, 
sub-license, re-sell or allow other use or access to Metadata for any third party or commercial use.
B.  END USER will not attempt to, or encourage or assist any other person to, circumvent or modify any 
security technology that is part of the database.
C.  END USER will only access and retrieve Metadata for CDs for which END USER is an owner of a legal copy 
and END USER shall have obtained all necessary rights, licenses or clearances to make a backup digital copy 
of the audio-visual content. 
D. END USER agrees that he/she is age (13) thirteen or older.
6.  LICENSE FEE
In consideration of the license granted herein, END USER acknowledges that it paid a License Fee as part of 
the purchase price of the Designated Equipment.  

5.  DATABASES AND METADATA CONTENT
A.  Copyrighted Materials.  GET DIGITAL DATA may provide access to certain Metadata which may include 
potentially copyrighted materials (“Copyrighted Materials”) such as cover artwork and album summary 
information. Such access is provided “as is” as an accommodation only, and GET DIGITAL DATA does not 
warrant or endorse and does not assume and will not have any liability or responsibility for such 
Copyrighted Materials or END USER’s use thereof.  END USER may only access and use such Copyrighted 
Materials to the extent allowed by law in END USER’s jurisdiction. END USER agrees that it will not use any 
such Copyrighted Materials in any manner that would infringe or violate this Agreement, any relevant law or 
the rights of any other party, and that GET DIGITAL DATA is not in any way responsible for any such use by 
END USER.
B.  Objectionable Material. END USER understands that the Metadata may contain content that may be 
deemed offensive, indecent, or objectionable, which content may or may not be identified with warnings, 
for example “explicit language”. END USER agrees to use the Metadata at its sole risk and GET DIGITAL DATA 
shall have no liability for content that may be found to be offensive, indecent, or objectionable. 
C.  Adult Material.  END USER understands that the Metadata may contain content that may be deemed 
adult material and governed by local or national standards and laws issued by a municipality, city, state, 
country, or other governmental entity.  END USER agrees to release, discharge, and hold harmless GET 
DIGITAL DATA from any and all liability which might arise from END USER’s or any third party’s accessing, 
allowing access to and/or using any adult content in the Metadata. 
D.  Submission of Material.  GET DIGITAL DATA may enable END USER to submit information to potentially be 
included as Metadata in GET DIGITAL DATA’S databases.  END USER agrees that any information submitted to 
GET DIGITAL DATA may be included or excluded from the databases at GET DIGITAL DATA’s sole discretion.  
END USER hereby grants GET DIGITAL DATA a non-exclusive, perpetual license and permission to copy and 
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include any such submitted information as Metadata in GET DIGITAL DATA’s databases and to make such 
information available to third parties who may access GET DIGITAL DATA’s databases.  END USER agrees to 
indemnify and hold harmless GET DIGITAL DATA from any and all claims, losses, liabilities, damages or 
expenses (including reasonable attorney fees) associated with claims, lawsuits and/or demands which are 
due to GET DIGITAL DATA’s use of information submitted by END USER.
E.  Content and Accuracy.  While GET DIGITAL DATA makes reasonable efforts to provide accurate 
information, END USER acknowledges and agrees that GET DIGITAL DATA is not responsible for examining or 
evaluating the content or accuracy of any third party materials or information contained in the Metadata. 
GET DIGITAL DATA does not warrant or endorse and does not assume and will not have any liability or 
responsibility for any third-party materials, or for any other materials, products, or services of third parties. 
GET DIGITAL DATA does not warrant that any Metadata it provides will be free from viruses, damaging source 
code or other destructive features.
F.  Changes to Databases.  GET DIGITAL DATA reserves the right to make changes to the Metadata and its 
databases at any time and without notice. GET DIGITAL DATA reserves the right to interrupt access to the 
databases and the Metadata as necessary to perform maintenance, error correction, or other changes. GET 
DIGITAL DATA may, at its sole discretion and without prior notice, block future access to the Metadata if END 
USER violates this Agreement.
G.  END USER represents and agrees that END USER does not gain any ownership of the Metadata or the 
database under this Agreement.  END USER acknowledges that the GET DIGITAL DATA’s databases are the 
sole property of GET DIGITAL DATA and/or its suppliers. END USER shall not have any right, title, or interest to 
any such databases or the Metadata except as provided in this Agreement.
H.  Proprietary Notices. END USER agrees to respect and not to remove, obliterate, or cancel from view any 
copyright, trademark, patent, confidentiality or other proprietary notice, mark, or legend appearing on any 
of the databases or Metadata generated by the databases and Metadata.  END USER further agrees END 
USER shall obtain no rights in any of GET DIGITAL DATA’S trademarks, copyrighted material or other 
intellectual property, which shall remain the sole property of GET DIGITAL DATA, and all goodwill acquired 
through use of the trademarks shall inure to GET DIGITAL DATA.

6. CONFIDENTIALITY
A.  Acknowledgement. END USER hereby acknowledges and agrees that the Metadata constitutes and 
contains valuable proprietary products and trade secrets of GET DIGITAL DATA and/or its suppliers, 
embodying substantial creative efforts and confidential information, ideas, and expressions. Accordingly, 
END USER agrees to treat (and take precautions to ensure that its employees treat) the Metadata as 
confidential information in accordance with the confidentiality requirements and conditions set forth below.
B.  Maintenance of Confidential Information. END USER agrees to keep confidential all confidential 
information disclosed to it by GET DIGITAL DATA in accordance herewith at all times exercising at least a 
reasonable degree of care in the protection of confidential information; provided, however, that END USER 
shall not have any such obligation with respect to use of disclosure to others not parties to this Agreement 
of such confidential information as can be established to: (1) have been known publicly; (2) have been 
known generally in the industry before communication by the disclosing party to the recipient; (3) have 
become know publicly, without fault on the part of the recipient, subsequent to disclosure by the disclosing 
party; (4) have been known otherwise by the recipient before communication by the disclosing party; or (5) 
have been received by the recipient without any obligation of confidentiality from a source (other than the 
disclosing party) lawfully having possession of such information.
C.  Injunctive Relief. END USER acknowledges that the unauthorized use, transfer or disclosure of the 
Metadata or copies thereof will: (1) substantially diminish the value to GET DIGITAL DATA of the trade secrets 
and other proprietary interests that are the subject of this Agreement; (2) render GET DIGITAL DATA's remedy 
at law for such unauthorized use, disclosure or transfer inadequate; and (3) cause irreparable injury in a short 
period of time. If END USER breaches any of its obligations with respect to the use or confidentiality of the 
Metadata, GET DIGITAL DATA shall be entitled to equitable relief to protect its interests therein, including, 
but not limited to, preliminary and permanent injunctive relief.
D.  Survival. END USER's obligations under this Section will survive the termination of this Agreement or of 
any license granted under this Agreement for whatever reason.

Download from Www.Somanuals.com. All Manuals Search And Download.



13

7.  WARRANTIES; SUPERIOR RIGHTS
A.  Ownership of Databases And Warranties.  GET DIGITAL DATA represents and warrants that it is the rightful 
owner and curator of the databases and that it has compiled the Metadata therein.  GET DIGITAL DATA does 
not represent or warrant that it is the rightful owner of any specific information in the Metadata and 
specifically disclaims ownership of any third-party copyrighted material in the databases, including any 
artwork or album summary information.
B.  Limited Warranty. GET DIGITAL DATA represents and warrants to END USER that access to the Metadata 
when properly enabled, will perform substantially as described in GET DIGITAL DATA's current 
documentation, found at: www.getdigitaldata.com .
C.  Limitations. Notwithstanding the warranty provisions set forth herein, all of GET DIGITAL DATA's 
obligations with respect to such warranties shall be contingent on END USER's use of the Metadata in 
accordance with this Agreement. 
D.  END USER's Sole Remedy. GET DIGITAL DATA's entire liability and END USER's exclusive remedy for any 
breach of these warranties shall be, at GET DIGITAL DATA's option: (1) repair to enable access to the 
Metadata; provided GET DIGITAL DATA receives written notice from END USER during the warranty period of 
a breach of warranty.
E.  Disclaimer of Warranties. THE METADATA IS PROVIDED ON AN "AS IS" BASIS ONLY. OTHER THAN SPECIFIED 
HEREIN, ALL EXPRESS AND IMPLIED WARRANTIES ARE HEREBY DISCLAIMED, INCLUDING THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, OR NON-INFRINGEMENT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU.
GET DIGITAL DATA DOES NOT REPRESENT OR WARRANT THAT ALL ERRORS IN THE METADATA WILL BE 
CORRECTED.  NO AGENT OF GET DIGITAL DATA IS AUTHORIZED TO ALTER OR EXCEED THE WARRANTY 
OBLIGATIONS AS SET FORTH HEREIN.
F.   Limitation of Liability. END USER ACKNOWLEDGES AND AGREES THAT THE CONSIDERATION WHICH GET 
DIGITAL DATA IS CHARGING HEREUNDER DOES NOT INCLUDE ANY CONSIDERATION FOR ASSUMPTION BY 
GET DIGITAL DATA OF THE RISK OF END USER'S CONSEQUENTIAL OR INCIDENTAL DAMAGES WHICH MAY 
ARISE IN CONNECTION WITH END USER'S USE OF THE METADATA. ACCORDINGLY, END USER AGREES THAT 
GET DIGITAL DATA SHALL NOT BE RESPONSIBLE TO END USER FOR ANY LOSS-OF-PROFIT, INDIRECT, 
INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE LICENSING OR USE OF THE 
METADATA. Any provision herein to the contrary notwithstanding, the maximum liability of GET DIGITAL 
DATA to any person, firm or corporation whatsoever arising out of or in the connection with any license, use 
or other employment of any Metadata delivered to END USER hereunder, whether such liability arises from 
any claim based on breach or repudiation of contract, warranty, tort or otherwise, shall in no case exceed the 
actual price paid to GET DIGITAL DATA by END USER for the License whose use, or other employment gives 
rise to the liability. The essential purpose of this provision is to limit the potential liability of GET DIGITAL 
DATA arising out of this Agreement. The parties acknowledge that the limitations set forth in this Section are 
integral to the amount of consideration levied in connection with the license of the Metadata and any 
services rendered hereunder and that, were GET DIGITAL DATA to assume any further liability other than as 
set forth herein, such consideration would of necessity be set substantially higher.

8.  INDEMNIFICATION
A.  GET DIGITAL DATA shall indemnify, hold harmless and defend END USER against any action brought 
against END USER to the extent that such action is based on a claim that, the Metadata, when used in 
accordance with this Agreement, infringes the intellectual property rights of a third party and GET DIGITAL 
DATA shall pay all costs, settlements and damages finally awarded; provided, that END USER promptly 
notifies GET DIGITAL DATA in writing of any claim, gives GET DIGITAL DATA sole control of the defense and 
settlement thereof and provides all reasonable assistance in connection therewith. If any Metadata is finally 
adjudged to so infringe, or in GET DIGITAL DATA's opinion is likely to become the subject of such a claim, 
GET DIGITAL DATA shall, at its option, either: (1) procure for END USER the right to continue using the 
Metadata (2) modify or replace the Metadata to make it non-infringing, or (3) provide a partial refund. GET 
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DIGITAL DATA shall have no liability regarding any claim arising out of: (a) use of other than a current, 
unaltered release of the Metadata unless the infringing portion is also in the then current, unaltered release, 
(b) use of the Metadata in combination with non-GET DIGITAL DATA software, data or equipment if the 
infringement was caused by such use or combination, (c) any modification or derivation of the Metadata not 
specifically authorized in writing by GET DIGITAL DATA or (d) use of third party software. THE FOREGOING 
STATES THE ENTIRE LIABILITY OF GET DIGITAL DATA AND THE EXCLUSIVE REMEDY FOR END USER RELATING 
TO INFRINGEMENT OR CLAIMS OF INFRINGEMENT OF ANY COPYRIGHT OR OTHER PROPRIETARY RIGHT BY 
THE METADATA.
B.  Except for the foregoing infringement claims, END USER shall indemnify and hold harmless GET DIGITAL 
DATA, their officers, agents and employees from and against any claims, demands, or causes of action 
whatsoever, including without limitation those arising on account of END USER's modification or 
enhancement of the Metadata or otherwise caused by, or arising out of, or resulting from, the exercise or 
practice of the license granted hereunder by END USER, its subsidiaries or their officers, employees, agents 
or representatives.

9.  TERMINATION FOR CESSATION OF BUSINESS.  
Get Digital Data may terminate this Agreement if Get Digital Data ends its business activity of supporting 
and maintaining the Metadata database.

10.  POST TERMINATION RIGHTS
Upon the expiration or termination of this Agreement, all rights granted to END USER under this Agreement 
shall forthwith terminate and immediately revert to GET DIGITAL DATA and END USER shall discontinue all 
use of the Metadata and the like.

11.  INFRINGEMENTS
A.  GET DIGITAL DATA shall have the right, in its sole discretion, to prosecute lawsuits against third persons 
for infringement of GET DIGITAL DATA's rights in the Metadata related to this Agreement with END USER or 
are otherwise brought to GET DIGITAL DATA’s attention by END USER.
B.   END USER agrees to fully cooperate with GET DIGITAL DATA in the prosecution of any such suit.  GET 
DIGITAL DATA shall reimburse END USER for the expenses incurred as a result of such cooperation.

12.  INDEMNITY
A.  GET DIGITAL DATA agrees to defend, indemnify and hold END USER, its officers, directors, agents and 
employees, harmless against all costs, expenses and losses (including reasonable attorneys' fees and costs) 
incurred through claims of third parties against END USER based on a breach by GET DIGITAL DATA of any 
representation and warranty made in this Agreement.
B.  END USER agrees to defend, indemnify and hold GET DIGITAL DATA, its officers, directors, agents and 
employees, harmless against all costs, expenses and losses (including reasonable attorneys' fees and costs) 
incurred through claims of third parties against GET DIGITAL DATA based on a breach by END USER of any 
representation made in this Agreement, or otherwise by any action of END USER that is not covered by the 
indemnification provisions of GET DIGITAL DATA in the Agreement.

13.   FORCE MAJEURE
Neither party shall be liable for any loss or delay resulting from any force majeure event, including acts of 
God, fire, natural disaster, terrorism, labor stoppage, war or military hostilities, or inability of carriers to make 
scheduled deliveries, and any payment or delivery date shall be extended to the extent of any delay 
resulting from any force majeure event.

14.  JURISDICTION AND DISPUTES
A.  This Agreement shall be governed by the laws of Indiana. 
B.   All disputes hereunder shall be resolved in the applicable state or federal courts of Indiana. The parties 
consent to the exclusive jurisdiction of such courts, agree to accept service of process by mail, and waive any 
jurisdictional or venue defenses otherwise available.

Download from Www.Somanuals.com. All Manuals Search And Download.



1515

15.  AGREEMENT BINDING ON SUCCESSORS
This Agreement shall be binding upon and shall inure to the benefit of the parties hereto, their heirs, 
administrators, successors and assigns.

16.  WAIVER
No waiver by either party of any default shall be deemed as a waiver of any prior or subsequent default of 
the same or other provisions of this Agreement.

17.  SEVERABILITY
If any provision hereof is held invalid or unenforceable by a court of competent jurisdiction, such invalidity 
shall not affect the validity or operation of any other provision and such invalid provision shall be deemed to 
be severed from the Agreement.

18.  ASSIGNABILITY
The license granted hereunder is personal to END USER and may not be assigned by any act of END USER or 
by operation of law unless in connection with a transfer of substantially all the assets of END USER or with 
the consent of GET DIGITAL DATA.

19.  INTEGRATION
This Agreement constitutes the entire understanding of the parties, and revokes and supersedes all prior 
agreements between the parties and is intended as a final expression of their Agreement. It shall not be 
modified or amended except in writing signed by the parties hereto and specifically referring to this 
Agreement. This Agreement shall take precedence over any other documents that may be in conflict 
therewith.
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Before you begin

Dear RCA Customer, 
Thank you for purchasing the Player.  This product will play mp3 and Windows Media™ audio (WMA) 
content.

RCA easyRip™ Media Software lets you import music files from CDs and other sources, organize your music 
library, and transfer unprotected MP3 and WMA files to and from this player.

Copyright warning
This player is for your personal use only. Unauthorized recording or duplication of copyrighted material may 
infringe upon the rights of third parties and may be contrary to copyright laws.

Back up your data
As with any portable player, you must back up the drive regularly. The manufacturer is not responsible for 
lost data.

Unpacking your player
All of the items listed below should have been packed in the box with your player.
• RCA player (contains music management software installer and user manual)
• Quick Start Guide
• USB cable
• Earphones

Computer system requirements
•  Pentium III 500MHz or higher recommended
• Windows® XP (service pack 1 or higher) or Windows Vista™ or Windows® 7
• Internet Explorer 6.0 or higher with Internet access
• Windows Media Player 10 or higher
•  250MB or more free hard disk space for the software
•  128MB RAM (256MB recommended)
• CD-ROM drive capable of digital audio extraction
• USB port (2.0 recommended)
• Sound card

Windows, Windows Media, and Windows Vista are trademarks or registered trademarks of Microsoft Corporation in the United States and other 
countries.
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Connecting to the computer
• Connect the player to your computer with the USB cable provided. The player will turn on automatically. 
• The player will be connected in MSC (Mass Storage Class) mode. It will appear as a drive letter on your 

computer and behave as a detachable drive for file transfer in one or both directions.
• The RCA easyRip™ Media Software installer is stored on the player. Go to My Computer (XP users) /Go to 

Computer (Vista and 7 users) in the Start menu, find and open the drive letter associated with the player 
(i.e. RCA MP3) and then double-click the rcaeasyrip_setup.exe file to launch the installer. 

• The software installer can be deleted from the player after installation to free up more storage space*. 

Player USB port of your 
computer

USB cable

* The latest software can be downloaded from www.rcaaudiovideo.com.
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• It may take several seconds for the player to be detected. Click View -> Refresh  in My 
Computer or Windows Explorer to make sure the player has been detected.

• The player is capable of transferring files at USB 2.0. If a USB 2.0 port is available on your 
computer, use it to connect to your player. The player is still backward compatible with the 
older USB 1.1 ports; however, you will not be able to take full advantage of the potential speed 
increase.

• IMPORTANT: Do not disconnect the USB connection from either the PC or the player during the 
software installation.

Charging the player
The player charges automatically every time you connect it to your computer. The player should be charged 
for at least 5 hours before using for the first time. 

To fully charge the player, make sure your computer is on and the player is connected for at least 5 hours. 
Refer to the battery level icon   on the display to check the battery level. Recharge the player when the 
icon is empty.
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Managing files on your RCA Player

Before you begin using your RCA player, you’ll want to copy your media files to the player. You can use any 
of the following methods to transfer content:

• RCA easyRip
• Drag and drop files using Windows Explorer

Using RCA easyRip
easyRip lets you:
• Import music from CDs
• Organize your music library on your PC
• Create Playlists
• Copy files from your library to the player
• Copy files from the player to your library
• Delete files from the player

To start easyRip:
• Click on the RCA Detective system tray icon and select RCA easyRip from the menu.
• Double-click the easyRip icon on your PC’s desktop. The easyRip dock appears at the side of your screen.

 

• Help – For detailed explanation on using easyRip, click the Help module on the Module 
Dock.  

• Video files must be converted and transferred via RCA easyRip for playback on your player.
• Video and photo files must be transferred to their respective folders on the player to 

ensure proper detection and playback.
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Using Windows Explorer
To copy files in MSC mode:
1. Open the player in Windows Explorer.

 
2. Drag and drop music files into the Music folder; photo files into the Photo folder; video files into the 

Video folder and text file to the Text folder.

 

Deleting files from the player
You may delete any files transferred to the player.
1. Connect the player to your computer.

2. Open the player in Windows Explorer and then navigate to the folder containing the files.

3. Select the files you want to remove and then press the Delete key on the keyboard of your PC.

Disconnecting the player from the PC
1. In the Windows system tray, click the Safely Remove Hardware icon  and then select the device with 

the appropriate drive letter from the list of devices.

2. When the Safe to remove hardware message appears, unplug the player from the PC.

IMPORTANT: Do not disconnect the USB connection during file transfer. Doing so may corrupt 
system files or the files being transferred.

20
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General controls

Turning the player on and off
Turn player on/off: Press and hold  button for a moment.

Lock or unlock the touch screen and key
Lock/ Unlock player controls: Press and hold Home

Resetting the player
If the player stops operating properly, you can reset it by pressing the RESET button on the back of the 
player with a non-metal pointed object (e.g. toothpick).

Display

Earphones 
Jack

Reset  
button

Power 
on/offUSB 

jack

Home
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Using the menus

The Home menu
The top-level or “Home” menu is always displayed when you press the Home button. The menu options are:

Audio
Select to start audio playback, and choose an artist, album, genre, individual title or recorded 
files.

Video
Select to enter the Video menu and choose a particular video for viewing. 

Photo
Select to enter the Photo menu and choose a particular image for viewing. 

Radio
Select to listen to Radio and choose different options in radio menu.

Text Reader
Select to enter the Text menu and choose a particular file for reading.

Voice Rec
Select to enter the Voice Rec menu to start voice recording.

File Manager 
Select to enter the File Manager to browse for files.

Applications
Select to enter the Applications menu to select an application.
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Settings
Select to enter the Settings menu, which lets you:
• Display the firmware version, space used, and space available
• Set date and time
• Change the language of the player’s menus
• Change the screensaver setting and screen brightness
• Calibrate the touch screen
• Choose the power save setting
• Reset the player’s settings to the factory defaults. 
• Format device to cleanup all data. 

Download from Www.Somanuals.com. All Manuals Search And Download.



24

Playing music files
From the Home menu select Audio.
 
Tap Library to navigate through the Audio Library. The player sorts your audio files by track name (title), 
artist, album, genre and recorded files. Select the desired item and tap Play to start playback or tap Now 
Playing to return to the now playing screen. 

To delete file, tap delete in the browsing screen.

Music playback

1

9 10 11

5 6 7 8
4

3

2

1. Playing sequence: Normal, Repeat one, Repeat all, Shuffle mode.
2. EQ style
3. Playback progress bar, drag the dot on the bar to navigate to different time of the playback file
4. Current file number/total number of files
5. Skip to the previous file; press and hold to scan backwards within a file
6. Start/ pause playback
7. Skip to the next file; press and hold to scan forward within a file
8. Show volume bar. Drag the dot on the bar to adjust volume.
9. Browse different song lists (Title, Artist, Album, Genre and Recorded files)
10. Show Custom EQ
11. Return to Home menu

Custom EQ
When listening to a file, tap Custom EQ to set personalized EQ. Drag the dot on the bar to select different 
sound effects and tap OK to confirm.

To exit without saving, tap Now Playing to return to previous screen.

Audio
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Video

• Video files must be converted to the optimal format for playback on this player. The RCA 
easyRip Media Software converts the video files automatically before transferring to the 
player. "File format is not supported!" will be displayed if the video file is not converted by 
the RCA easyRip.

• The player remembers where you stopped last time when playing a video file. Select Yes when 
"Continue last play?" prompts if you would like to continue playback from the last session. 

Playing video files
From the Home menu select Video.

Navigate through the browser and select the desired item to start viewing.

Video viewing

1 2 3 4 5

6

1. Browse Video folder
2. Skip to previous file
3. Start/pause playback
4. Skip to next file
5. Show volume bar. Drag the dot on the bar to adjust volume. 
6. Playback progress bar, drag the dot on the bar to navigate to different time of the playback file
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Photo

Playing photo
From the Home menu select Photo.

Navigate through the browser and select the desired item to start viewing.

Viewing photo

1 2 3 4 5

1. Browse Photo folder
2. Skip to previous file
3. Start/pause slideshow if it is activated
4. Skip to next file
5. Set slideshow time interval. Press OK to save and exit.
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Radio

The radio uses the earphones as an antenna. For better reception, extend the earphone cable 
as far as possible. 

Playing FM radio
From the Home menu select Radio.

1

2 3 4

5

6 7 8

1. Press to select Manual tuning or Preset tuning
2. Step down the frequency range. Skip to previous Preset station under Preset tuning mode.
3. Turn on/off mute
4. Step up the frequency range. Skip to next Preset station under Preset tuning mode.
5. Volume bar. Drag the dot on the bar to adjust volume. 
6. Display Preset channel list
7. Enter Option menu
8. Exit radio and return to the Home menu

Option menu
Tap Menu to show the Option menu. The following options are available:

• Save to Preset – Save current station to the Preset channel list. Select OK to 
save current station.

•  Record Mode – Go to Record mode screen, select record to start recording FM 
radio. The player names each recording RECXXX.WAV, where XXX is a unique 
number. 

•  Auto Program Preset– This feature will automatically load the Preset list with 
stations that the player can find in your area.  When selecting this option your 
player will scan through the FM band looking for available stations.  It will 
momentarily stop at each station it discovers. Once the process is complete, 
the radio will tune to the first Preset station found.

•  Freq Step – Select frequecy step (Freq step 200kHz(US) or Freq step 
100kHz(Others))

•  Delete Preset– Delete station from the Preset channel list.
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Text Reader 

From the Home menu select Text Reader.

Navigate through the browser and select the desired item to start reading.

Reading .txt file

1 2

3 4

1. Skip to previous page
2. Skip to next page
3. Browse TXT folder
4. Enter Option menu

Option menu
Tap Menu to show the Option menu. The following options are available:

• Save Tags – Set a Tag on the current page.
•  Jump to – Fast access within a text file.
•  Extract Tags – Select and go to a previously set Tag.
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Voice recording

Start recording
From the Home menu select Voice Rec.

1

2 3

4 5

1. Record progress bar
2. Start/pause recording
3. Save recording
4. Select recording's quality (32k, 64k and 128k) when recording is stopped
5. Return to the previous screen

Playback recording
To select a desired file to playback, enter Audio mode and select Recorded files from the browser. The 
recorded file is named as MICXXX.WAV. See Audio section for more details.

As for FM recordings, the player names each recording RECXXX.WAV, where XXX is a unique number.  

Make sure nothing is covering the MIC opening during recording.
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File manager

From the Home menu select File Manager.

You can browse folders and files in the device. Navigate through the browser and select the desired folder or 
item to start playback or viewing. You can also delete selected file.
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Applications

From the Home menu select Applications.

Calendar
Tap  or  to select month and year. Select date by directly clicking on the number on the screen. The 
number will then be highlighted in blue.

Stopwatch
Tap Start/Pause to start/pause counting. Tap Lap to start lap counting.  The player can record up to five laps. 
Tap clear to clear previous data.

Bomb Field
1. Select game level: Easy or Hard. 
2. Tap "Mine" button to switch to the mode which allows the player to mark the suspected locations of 

bombs.  Tap the "Sign" button to revert back to the mode which allows player to mark the areas where 
no bombs are suspected. 

3. Tap  to start a new game.

Download from Www.Somanuals.com. All Manuals Search And Download.



32

Settings

From the Home menu select Settings.

  
• Display the firmware version, space used, and space available
• Set date and time
• Change the language of the player’s menus
• Change the screensaver setting and screen brightness
• Calibrate the touch screen
• Choose the power save setting
• Reset the player’s settings to the factory defaults. Select Yes to confirm reset to defaults.
• Format device to cleanup all data. Select Yes to confirm. 
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Tips and troubleshooting
Cannot delete files on the player.
•  You can delete files on the player using your computer.

1.  Connect the player to your computer.
2.  Open the player in Windows Explorer and navigate to the folder containing the files.
3.  Select the files you want to remove and then press the Delete key on the keyboard of your PC.

• For deleting files from the player, see File Manager menu for details.
•  For deleting files using easyRip, click the Help module on easyRip’s Module Dock.

Audio distorted at high volume.
• Change the Equalizer mode to Flat.
• Turn down the volume.

The audio tracks on my player keep skipping or popping.
• You’ll need to rip the audio track again– make sure you close all other applications on your PC when you 

record.
• Try ripping with the Error Correction setting turned on.

Player turns itself off.
• Your player turns itself off if you leave it in pause mode or navigation mode for the duration specified in 

Power Save setting.

The player cannot be turned on.
• Battery is empty, please recharge.
• Reset the player by pressing the RESET button on the back of the player with a non-metal pointed 

object (e.g. toothpick).”
• If the player still cannot be turned on after resetting, perform a firmware upgrade to restore it.

• Please go to www.rcaaudiovideo.com for more details.

Player does not respond to key presses.
• Make sure the lock function is not activated.
• If the player stops operating properly, you can reset it by pressing the RESET button on the back of the 

player with a non-metal pointed object (e.g. toothpick).
• This player may temporarily cease to function if subjected to electrostatic disturbance.
 To resume normal operation, it may be necessary to cycle the power off and back on or you can reset it 

by pressing the RESET button on the back of the player with a non-metal pointed object (e.g. toothpick).

Player cannot play WMA songs.
• Secure music downloads are not supported by this player. Please make sure to download songs without 

DRM protection (Digital Rights Management). 

Additional information
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The player takes a long time to read files in a folder.
• File reading may take longer if too many files are put in a single folder. Re-organize your files into a 

number of folders. 

Song information is not showing correctly.
• Song information may not match your current player’s language setting. Change the language setting.  

Cannot view photo files.
• The player only supports. jpg, .bmp, .tiff, .png, gif.

• NOTE: Other format of photo files may not be supported.
• Photo files must be transferred to the “Photo” folder in the player for proper playback.

Cannot play video files.
•  All video files must be converted by RCA easyRip software. 

• NOTE: Your PC must be able to play the video file in Windows Media Player to ensure the proper 
codecs are installed for video conversion.

• Video files must be transferred to the "Video" folder in the player for proper playback.

Cannot play audible book.
• Audible files are not supported by this player.

Cannot play AAC songs.
• AAC songs are not supported by this player.

The player reports that it is full.
•  The internal memory of the player has been filled to capacity.
•  You have exceeded the maximum number of files (1,999) supported by the player.

•  NOTE: The maximum folder depth is 8 folders.

Cannot playback tracks on the player. 
•  Make sure audio tracks are encoded in the mp3 or Windows Media formats at supported bitrates.
• Bitrates support by the player:
 mp3 – 32 to 320 kbps
 wma – 48 to 192 kbps
•  WMA files may be DRM protected and this player does not support playback of protected files.

Cannot playback songs downloaded from my paid Music Server Provider subscription service.
• Secure music downloads are not supported by this player. Please make sure to download songs without 

DRM protection (Digital Rights Management). 

Cannot transfer subscription music content to the player.
•  Secure music downloads are not supported by this player. Please make sure to download songs without 

DRM protection (Digital Rights Management). 

Cannot launch RCA easyRip installer stored in the player to install easyRip on my PC. 
• The easyRip Media Software installer is stored in the player.  With the player connected to the computer 

USB port, go to My Computer desktop icon or through the Start Menu.  Next find and open the drive 
letter associated with the player (i.E. RCA MP3) and then double-click the rcaeasyrip_setup file to launch 
the installer.

How to format device?
•  Perform a format to remove all data from player (Home => Settings => Format Device). 
•  IMPORTANT: Backup your media before formatting the player.
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Visiting RCA website
Please visit www.rcaaudiovideo.com for:
• Product registration
• Latest software and firmware
• Latest RCA easyRip software
• User manual
• Frequently asked questions (FAQ)
• Customer service and technical support information 

Technical specification
Power source:
• Built-in rechargeable lithium-polymer battery 3.7V 
• USB power (from a computer via the supplied USB cable) 

Specifications
Hardware
• Dimensions: 95 mm H, 56.3 mm W, 11 mm D
• Unit Weight: 65 g
• Stereo Headphones jack
• USB Connection Jack
• Battery Operated: Rechargeable lithium battery.

USB Drive
• External USB Drive: When connected to a computer via USB, the player is capable of storing any file type 

allowing the user a fast, convenient method of storing, retrieving, and transferring files. This includes 
word processing files, presentations, spreadsheets and any other computer files.

• Capacity: 4GB* (M7204), 8GB* (M7208)
• Connection: USB 2.0, Hi-speed capable

Software
• Includes the player applications and media management software.

*  Actual playtime, number of songs and available storage space will vary depending on system requirements, bitrate and other factors.
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Warranty information

12 Month Limited Warranty
Applies to RCA Portable Media Players

AUDIOVOX ACCESSORIES CORP. (the Company) warrants to the original retail purchaser of this product that 
should this product or any part thereof, under normal use and conditions, be proven defective in material or 
workmanship within 12 months from the date of original purchase, such defect(s) will be repaired or 
replaced with reconditioned product (at the Company’s option) without charge for parts and repair labor.

To obtain repair or replacement within the terms of this Warranty, the product is to be delivered with proof 
of warranty coverage (e.g. dated bill of sale), specification of defect(s), transportation prepaid, to the 
Company at the address shown below.

This Warranty does not extend to the elimination of externally generated static or noise, to correction of 
antenna problems, loss/interruptions of broadcast or internet service, to costs incurred for installation, 
removal or reinstallation of product, to corruptions caused by computer viruses, spyware or other malware, 
to loss of media, files, data or content, or to damage to tapes, discs, removable memory devices or cards, 
speakers, accessories, computers, computer peripherals, other media players, home networks or vehicle 
electrical systems.

This Warranty does not apply to any product or part thereof which, in the opinion of the Company, has 
suffered or been damaged through alteration, improper installation, mishandling, misuse, neglect, accident, 
or by removal or defacement of the factory serial number/bar code label(s). THE EXTENT OF THE COMPANY’S 
LIABILITY UNDER THIS WARRANTY IS LIMITED TO THE REPAIR OR REPLACEMENT PROVIDED ABOVE AND, IN 
NO EVENT, SHALL THE COMPANY’S LIABILITY EXCEED THE PURCHASE PRICE PAID BY PURCHASER FOR THE 
PRODUCT.

This Warranty is in lieu of all other express warranties or liabilities. ANY IMPLIED WARRANTIES, INCLUDING 
ANY IMPLIED WARRANTY OF MERCHANTABILITY, SHALL BE LIMITED TO THE DURATION OF THIS WRITTEN 
WARRANTY. ANY ACTION FOR BREACH OF ANY WARRANTY HEREUNDER INCLUDING ANY IMPLIED 
WARRANTY OF MERCHANTABILITY MUST BE BROUGHT WITHIN A PERIOD OF 24 MONTHS FROM DATE OF 
ORIGINAL PURCHASE. IN NO CASE SHALL THE COMPANY BE LIABLE FOR ANY CONSEQUENTIAL OR 
INCIDENTAL DAMAGES FOR BREACH OF THIS OR ANY OTHER WARRANTY. No person or representative is 
authorized to assume for the Company any liability other than expressed herein in connection with the sale 
of this product.

Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of 
incidental or consequential damage so the above limitations or exclusions may not apply to you. This 
Warranty gives you specific legal rights and you may also have other rights which vary from state to state.
 
Recommendations before returning your product for a warranty claim:
• If your product is capable of storing content (such as an mp3 player, voice recorder, camcorder, digital 

photo frame, etc), it is recommended to make periodic backup copies of content stored on the product. If 
applicable, before shipping a product, make a back up copy of content or data stored on the device. Also, 
it is advisable to remove any personal content which you would not want exposed to others. IT IS LIKELY 
THAT CONTENTS AND DATA ON THE DEVICE WILL BE LOST DURING SERVICE AND REFORMATTING. 
AUDIOVOX ACCEPTS NO LIABILITY FOR LOST CONTENT OR DATA, OR FOR THE SECURITY OF ANY 
PERSONAL CONTENT OR DATA ON THE RETURNED DEVICE. Product will be returned with factory default 
settings, and without any pre-loaded content which may have been installed in the originally purchased 
products.  Consumer will be responsible for reloading data and content. Consumer will be responsible to 
restore any personal preference settings. 
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• Properly pack your unit. Include any remotes, memory cards, cables, etc. which were originally provided 
with the product. However DO NOT return any removable batteries, even if batteries were included with 
the original purchase. We recommend using the original carton and packing materials. Ship to

Audiovox Electronics Corp.
Attn: Service Department.
150 Marcus Blvd.  
Hauppauge N.Y. 11788

1-800-645-4994
     

For Canada Customers, please ship to:
Audiovox Return Centre
c/o Genco
6685 Kennedy Road,
Unit#3, Door 16,
Mississuaga, Ontario
L5T 3A5
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Illustrations contained within this publication are for representation only and subject to change.

The descriptions and characteristics given in this document are given as a general indication and not as a 
guarantee.  In order to provide the highest quality product possible, we reserve the right to make any 
improvement or modification without prior notice. 

Visit http://store.audiovox.com to find the 
best accessories for your products. 
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